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ABSTRACT

A sampling design that can provide estimates of abundance with low variance is 

very valuable to biologists working with limited budgets and time. Estimates that are 

precise even with low sampling efforts allow researchers to cheaply and confidently 

monitor rare populations. Adaptive cluster sampling has the potential to be much more 

efficient at sampling rare populations than conventional sampling designs, but it has also 

been shown to be highly inappropriate for some populations. Applications of adaptive 

cluster sampling (ACS) have had inconsistent results in real-world settings, leading to 

increasing scrutiny of the factors that influence the efficiency of this design. Much more 

work still needs to be done in order to provide samplers with the knowledge of when 

ACS is appropriate and how to maximize its effectiveness through constructing an 

optimal design. This study develops a procedure in a GIS environment for rigorously 

examining the effects of design parameters on the variance of ACS estimates, and applies 

this procedure to some real-world point populations. The relative efficiency of adaptive 

cluster sampling to simple random sampling is shown to be dramatically influenced by 

design parameters. This highlights the need for further investigation and a better 

understanding of how these parameters interact with point distributions through the use of 

procedures and tools such as those introduced here.
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INTRODUCTION

In ecological studies, efficiently sampling rare species is a difficult challenge. 

Conventional sampling designs may require substantial effort in order to achieve even 

moderate precision (e.g. Evans and Viengkham 2001). Unfortunately, accurate estimates 

of abundance are often most needed for rare species. Adaptive cluster sampling is 

attractive because it can perform more efficiently than conventional designs for 

geographically rare, clustered populations. It allows biologists to survey larger fractions 

of the target population while providing design-unbiased estimates. Unfortunately, the 

adaptive cluster sampling design is not appropriate for all populations, and has sometimes 

resulted in excessive survey costs for very little benefit (Smith et al. 2003). While many 

articles on adaptive cluster sampling have been published since it was first described by 

Thompson (1990), accounts describing direct applications of the design have been 

limited. What’s more, these applied studies show a remarkable variability in the 

performance of adaptive cluster sampling in field settings (Smith et al. 2004). It is 

apparent that much more work is needed to provide guidelines that will allow biologists 

to realize the potential of this design.

Adaptive cluster sampling (ACS) was proposed by Thompson (1990) specifically 

with rare, clustered populations in mind. The ACS design calls for an initial sample of n1

units to be drawn from a defined universe (a finite set of basic sampling units) according 

to a conventional sampling design, such as simple random sampling (SRS). It then 

operates under the rule that if any of these initially selected units satisfies a certain 
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condition of interest, C, additional units in the neighborhood of that unit will be added to 

the sample. In area-based sampling, neighborhoods are usually defined based on spatial 

proximity, such as all units sharing an edge with the initially selected unit. In sampling 

biological populations, the condition to include additional units in a sample (C) is usually 

based on the count of individuals of the target population within the initial sample of 

units. Thus, any initially sampled units containing enough individuals to satisfy the 

condition C will cause additional units in their neighborhood to be added to the sample. If 

any of these additional units also satisfy C, further sampling of their neighborhoods 

occurs as well. This process continues until no further neighborhood units satisfy C. 

Through this process, ACS takes advantage of clustering within a population to make 

units containing interesting information more likely to be included in the sample. For 

example, in a sample of a spatially clustered population (Fig. 1) the condition C could be 

simply the presence of an individual (yi > 0), and any occupied quadrats in the initial 

sample would add neighboring quadrats until only empty units were encountered. The 

result is a set of clusters, each comprised of a core of units that satisfy C and an outer 

layer of edge units that do not. If all units in the realized adaptive sample received equal 

weight, conventional equal probability abundance estimators would be positively biased. 

However, Thompson (1990) showed that modified versions of the Horvitz-Thompson 

and Hansen-Hurwitz estimators could account for the unequal probabilities of selection 

imposed by the adaptive design. These estimators are design-unbiased (they are unbiased 

without relying on any assumptions about the population). 
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Figure 1. An example of an adaptive cluster sample. Numbered units are part of the 
initial sample, additional units that satisfy C are indicated with diagonal lines, and 
empty edge units are stippled.

Much theoretical work was done with the ACS design subsequent to its 

introduction in 1990, but very few direct applications were performed in biological 

settings until the last decade. While some recent studies have found ACS to live up well 

to its promising potential, the majority of studies have had either mixed or fully negative 

results regarding the applicability of ACS to real biological systems. Acharya et al.
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(2000) sampled rare tree species in Nepal and found ACS to work well for some but not 

for others, concluding that the applicability had to do with distribution characteristics of 

the different species (some were more clustered than others). Magnussen et al. (2005), 

who used ACS to estimate deforestation rates, and Hanselman et al. (2003) who used it to 

sample rockfish off Alaska found that it provided more precise estimates, but these gains 

in precision were offset by increasing costs due to adaptively adding sampling units, 

especially edge units. ACS has performed poorly for other researchers. A study by 

Morrison et al. (2008), comparing sampling designs with an aggregated winter annual 

plant, led them to conclude that the population’s distribution was simply inappropriate for 

ACS. Smith et al. (2003), Noon et al. (2006), and Goldberg et al. (2007) all 

acknowledged the fact that ACS was better at detecting a higher fraction of individuals 

within the population, but found that it uniformly failed to provide more precise estimates

of population size. 

The specific problems that samplers have had with ACS are in general due to 

either excessive realized sample sizes, a disproportionately high fraction of the sample 

being edge units, or bias of estimates resulting from the use of devices to curb excessive 

sample sizes. These general problems have been for the most part anticipated or duly 

noted by theoreticians over the years, and a number of articles have been published 

offering modifications of either the original basic design or estimators. Because the final 

size of the realized adaptive sample is unknown, it can be difficult to control the total 

sampling effort and accurately plan the cost of a survey in advance. Christman and Lan 

(2001) proposed an inverse ACS design meant to reduce final sample size. Brown and 
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Manly (1998) described a restricted ACS design that allows a preset limit on the final 

sample size to be imposed on ACS, and Salehi and Seber (2002) put together an unbiased 

estimator for this design. Thompson (1996) discussed a design that allows researchers to 

control the number of units added to a sample by ordering the values of the completed 

initial sample and using a certain percentile to choose the condition to further add units to 

the sample. Unfortunately, it is not always possible in real-world situations to completely 

finish the initial sample before adding units adaptively. Another downside of the ACS 

design is that the information from edge units is not incorporated into estimators unless 

they are encountered in the initial sample. Thus the ratio of edge units to network units 

can have a strong effect on the efficiency of ACS. Thompson and Seber (1996), Salehi 

(1999), and Dryver & Thompson (2005) have used what is known as the Rao-Blackwell 

method to develop estimators that utilize edge units, but are more complicated to 

calculate.

While most applications of ACS have been ineffective in some way, there have 

also been multiple examples of success. In an inventory of sparse forest populations, 

Talvitie et al. (2006) found ACS to be “considerably more effective” than SRS. Philippi 

(2005) successfully used ACS to estimate the abundance of local populations of low-

abundance plants, Skibo et al. (2008) employed a modified ACS design to efficiently 

sample red sea urchin populations and Sullivan et al. (2008) found ACS to work well for 

a large proportion of the sea lamprey populations they examined. These successes have 

been predicted in multiple simulation studies as well (Christman 1997, Christman & 

Pontius 2000). In these examples, performance has typically been based on the precision 
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of estimates provided by ACS relative to those from other, more conventional designs 

given an equal effort. Regardless of the precision of estimates, a frequently 

acknowledged benefit provided by ACS is its tendency to sample a higher fraction of 

occupied sample units, allowing additional information to be collected concurrent to the 

sample (Lo et al. 1997, Noon et al. 2006, Smith et al. 2003). This can be especially useful 

when studying rare or endangered species for which such additional information is 

frequently lacking. 

Overall there seems to be a gap between the theoretical potential of ACS and its 

realized performance in the field. In part, this is due to a characteristic of the ACS design 

that can be considered both an advantage and disadvantage. While ACS is in general 

recommended for rare, clustered populations, samplers have a considerable degree of 

flexibility in constructing a specific sample, potentially allowing it to be tailored to a 

wide variety of different situations and distributions. At the same time, it is the existence 

of so many different options that makes determining an optimal strategy so difficult. 

There are multiple alternatives for neighborhood type, the condition C, the size of the 

initial sample, the initial method of selecting the sample, the size of the basic sampling 

unit, and the estimator that utilizes the collected information. There have been several 

neighborhood definitions described for ACS (see Christman 2000) but the most common 

definition used in grid-based sampling is the first-order neighborhood, which includes the 

four immediately adjacent quadrats. Setting an appropriate C can be very important in 

designing an efficient adaptive cluster sample. Hanselman et al. (2003) determined 

retrospectively that had they used a more restrictive C they would have done substantially 
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less sampling with very little loss of estimation precision. The initial sample size (n1) 

must be set high enough to ensure the inclusion of some networks, but if set too high it 

may lead to excessive sizes of the realized adaptive sample. There are also a number of 

different options for selection of the initial sample, such as simple random sampling with 

or without replacement (Thompson 1990), strip sampling, systematic sampling 

(Thompson 1991a), stratified sampling (Thompson 1991b) and simple Latin square 

sampling (Borkowski 1999). Both the modified Hansen-Hurwitz and Horvitz-Thompson 

estimators suggested by Thompson (1990) have seen use in applied situations, and both 

have had advantages and disadvantages identified with them (Phillipi 2005, Salehi 2003).

Researchers have also consistently noted that the efficiency of ACS is dependant 

upon the spatial distribution patterns of the particular population being studied, but 

surprisingly little attention has been paid to sample design parameters that are fully under 

the control of samplers and significantly effect the distribution of point populations 

across grid-based sampling universes. In particular, White (2004) showed that for 

members of the Astragalus genus, an herbaceous member of the plant family Fabaceae, 

distributions in a grid-based setting can be highly influenced by both the placement of the 

grid and the size of the grid cells. Weigand (2007) found species to exhibit clustering at 

multiple spatial scales, and random distributions at other scales. Thus by coordinating the 

size of the basic sampling unit with the scale of clustering within the target population 

researchers can have a great deal of control over the effectiveness of ACS. 
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The first aim of this study is to develop and introduce a procedure that allows for 

the rigorous examination of the effects of a) size of basic sample units, b) size of the 

initial sample (sampling fraction) and c) the condition C on the performance of ACS with 

both the Hansen-Hurwitz and Horvitz-Thompson estimators. The second aim is to apply 

this procedure to real-world plant populations in order to explore the influence that 

design parameters can have on the efficiency of ACS relative to Simple Random 

Sampling.
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METHODS

Notation and Estimators

This study makes use of the modified versions of the Hansen-Hurwitz (HH) and 

Horvitz-Thompson (HT) estimators originally proposed by Thompson (1990) and 

compares them to the Simple Random Sample (SRS) estimator by calculating their 

relative efficiencies (Thompson & Seber 1996) at equal sample sizes.

In simple random sampling, the estimator of the population total ( ̂ ) given a 

random sample of n primary units from N total units is the sum of the y-values associated 

with each unit i included in the sample, divided by the probability that any unit i is 

included in the sample (πi). In this case the y-values will represent the number of 

individuals within each quadrat. Because each unit is equally likely to be included, πi is 

the same for all units and is equivalent to the fraction of the total sample space being 

sampled (n/N). The SRS estimator of the population total can be written as





n

i
iSRS y

n

N

1

ˆ (1)

The sampling variance of this estimator can be calculated as

   
n

nNNV SRS

2

ˆ 
 (2)

where 2 is the finite population variance,

 
2

1

2

1

1 






N

i
iy

N
 (3)
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and  is the population mean, or the average number of individuals per unit,





N

i
iy

N 1

1 (4)

Because inclusion probabilities for the units selected in an adaptive cluster sample 

are not all equal, conventional estimators such as SRS̂ are biased. Thompson (1990) 

suggested two design-unbiased estimators based on the Horvitz-Thompson (HT) and 

Hansen-Hurwitz (HH) estimators. Though past studies indicate that the HH estimator 

usually has a higher variance than the HT estimator, the HH estimator has seen as much 

if not more use in the field due to the complicated and laborious calculations associated 

with the HT estimator.

The true Horvitz-Thompson estimator is based on unit inclusion probabilities (πi), 

but with an adaptive cluster sample it is impossible to know the inclusion probabilities for 

every basic sampling unit that is selected. However, it is possible to know the probability 

of including a network in the sample. A network is a subset of the units found in a cluster, 

such that selection of any unit within the network would lead to the inclusion of all other 

units in the network. Units that don’t satisfy C but are in the neighborhood of one that 

does are known as edge units. Thus, a cluster with its edge units removed is a network. In 

addition, all units that fail to satisfy the condition C (including both edge and non-edge 

units) are considered networks of size one.
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When an adaptive cluster sample is partitioned into distinct networks instead of 

basic sampling units, the Horvitz-Thompson estimator for the population total can be 

modified and expressed as 





K

1

*

ˆ
k k

kk
HT

zy


(5)

Where *
ky is the total number of individuals in the kth network, K is the number of distinct

networks in the sample, and αk is the probability of including any unit in network k. If 

there are xk units in the kth network, then 
















 


11

1
n

N

n

xN k
k (6)

The sampling variance of this estimator is
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K
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(7)

where kh is the probability of including both network k and network h in the adaptive 

sample and is defined as
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The true Hansen-Hurwitz estimator is based on the probability of selecting a 

primary sampling unit on any given draw. Just as with inclusion probabilities though, 

draw-by-draw selection probabilities cannot be known for all primary units in the sample, 

but they are known for the networks that are encountered. The modified Hansen-Hurwitz 

estimator is 





1

11

ˆ
n

i
iHH w

n

N
T (9)

where wi is the average of the yi values in the network (Ai) that include the ith unit of the 

initial sample of size n1:
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and mi is the number of primary units in network Ai. The sampling variance of this 

estimator can be calculated as 









N

i
iHH w

nn

nNN
V

1

2

11

1 )(
)1(

)(
)ˆ(  (11)

The relative efficiency of adaptive cluster sampling is calculated as
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(12)

When RE > 1, the adaptive cluster sample is more efficient than the simple random 

sample (the design provides more accurate estimates of the population total at an equal

sample size). 
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The variance of the SRS estimator in equation 12 was calculated given a sample 

size equal to the expected final sample size (E(n*)) for the ACS design:

  



N

i
inE

1

*  , (13)

where πi is the probability of including unit i in the sample:
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mi is the number of units in the network to which unit i belongs, and ai is the number of 

units in the network of which unit i is an edge unit. Note that both πi and E(n*) can be 

determined only if the y-values and spatial locations of all basic sampling units are 

known.

Procedures

The starting point for this study was point distributions for six populations of rare, 

endangered plant species, with a wide range of abundances located in sites with a wide 

range of areas. These distributions were imported into a Geographical Information 

System (GIS) environment, where a variety of sampling scenarios based on changes in 

four design parameters were systematically applied to them. With each of these scenarios 

a specific set of GIS procedures (Appendix A) were used to extract information on 

universe attributes required for input into a set of specially designed R functions 

(Appendix B) for computing sampling variances using the two ACS variance estimators 

under different design conditions (R Development Core Team, 2004). These sampling 
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variances were then expressed as ratios relative to V( SRS̂ ) in order to provide 

comparisons across all six populations.

Of the six populations utilized here, four populations were of Western Lily 

(Lilium occidentale) and two were of Kneeland praire penny-cress (Noccaea fendleri ssp

californicum). Lilium occidentale is an herbaceous perennial flowing plant and occurs in 

bogs or coastal scrub in a narrow band from Eureka, California to Coos Bay, Oregon. It is 

known to occur at 28 sites, only four with as many as 1000 individuals, three with 100 to 

300 individuals and 21 with 100 or fewer. Noccaea fendleri ssp californicum only occurs 

within serpentine outcrops on Kneeland prairie (Humboldt Co, CA), numbering from 23 

to 9,000 individuals in a given outcrop. The six populations employed in this study are 

summarized in Table 1. The X,Y coordinates for all individuals in the populations are 

accurate to at least 0.5 meters and were supplied by Dave Imper of the USFWS, collected 

as part of each species’ management plan (U.S. Fish and Wildlife Service 1998, 2003). 

Site areas are approximate because the method used to overlay grids of varying scales 

sometimes resulted in total areas slightly larger than those stated.

Table 1. Summary information for case study populations. Population label, species
name, site area, total abundance, average nearest neighbor (NN) distance and the 
standard deviation (SD) of nearest neighbor distance.

Label Species Area (m2) T Avg NN (m) NN SD (m)

1 Lilium occidentale 15525 74 3.36 7.53

2 Lilium occidentale 9600 80 1.98 2.60

3 Noccaea fendleri ssp californicum 9100 116 1.43 2.11

4 Noccaea fendleri ssp californicum 9100 189 1.03 1.87

5 Lilium occidentale 6000 625 0.09 0.41

6 Lilium occidentale 220400 1997 0.67 2.88
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The point data for each population were imported into ArcGIS 9.1 (ESRI 2005) 

where grid-based sampling universes were simulated comprised of square primary units 

of lengths ranging from 1 m to 15 m. Prior to grid placement, a constant value of 0.01 

was added to the X,Y coordinates of the individuals in all populations (Appendix A, step 

3). As long as both this constant and the precision of the distance between gridlines were 

less than the precision of the point data, this technique effectively avoided the placement 

of a gridline directly upon a point. It should be noted that the effect of grid placement was 

not examined in this study, but is an issue that merits further investigation, as it has been 

shown to significantly affect the area of occupancy measures in grid-based settings such 

as this (White 2004).

Through further steps given in Appendix A, information required by functions 

written specifically for this study was exported and analyzed using computer programs 

written in R (R Development Core Team, 2004). Many current statistical analysis 

programs are not equipped to perform the necessary calculations to provide HT 

variances. Those that have the capabilities, such as R, don’t directly provide a tool for it, 

nor was one available on the web. The HT Variance Calculator designed for this study 

makes use of GIS extracted data as well as sample data and is fairly easy to use. This 

program and all other R functions written and used for this study are presented and 

explained in Appendix B. 

Four factors were considered in analyzing the performance of ACS relative to 

SRS. These factors were: a) nine spatial scales ranging from 1 m to 15 m, b) ten initial 

sampling fractions ranging from 0.01 to 0.50, c) two estimators (HT & HH), and d) two 
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conditions to include additional units in a sample (C1:{i: yi > 0}, C2: {i: yi > 1}). The 

relative efficiency of an ACS estimator given an initial sample size of n1 compared to a 

SRS estimator given a sample size of E(n*) was calculated for all possible combinations 

of these factors. While these comparisons were made at equal sample sizes, this does not 

necessarily imply equal sampling efforts, and no attempt was made in this study to 

correct for differences in distance traveled under SRS and ACS designs.



17

RESULTS

For all the populations examined in this study there were multiple conditions 

under which one or both of the ACS estimators were relatively more efficient than the 

SRS estimator given an equal final sample size. The Hansen-Hurwitz estimator 

performed uniformly worse than the Horvitz-Thompson estimator and rarely better than 

the SRS estimator, so only the performance of the HT estimator is presented here. 

Complete tables of the relative efficiencies of both the HT and HH estimators under all 

conditions are presented in Appendix D. 

For ease of interpretation, contour plots are used to represent the relative 

efficiencies under the various sampling conditions. The leftmost contour line represents a 

relative efficiency of one (RE=1), so the combinations of sample unit edge lengths and 

sampling fractions that fall within the area above and to the right of this contour line 

represent conditions under which ACS would perform better than SRS. In many cases the 

increase in RE across the plot is quite large, and additional contour lines have been added 

to indicate trends. Because efficiency at smaller sampling fractions is usually more 

desirable, a vertical tangent to the RE=1 contour line will indicate optimal combinations 

of sample unit lengths and initial sampling fractions if they exist. 

Population 1, with highly variable nearest neighbor distances (Table 1), roughly 

exhibits two optimal sample unit lengths; one at 4 meters and another at 7.5 meters (Fig. 

2). This may be an indication of clustering on multiple scales. Population 2 exhibits an 

optimal sample unit length of 3 meters (Fig. 3). Population 6, with the lowest density of 



18

points per area, had the most sets of conditions under which ACS outperformed SRS 

(Fig. 4). The flat appearance of the contour lines indicates that there was no sample unit 

length that could be considered “optimal” with respect to the other lengths. On the other 

hand, Population 5, with the highest density of points per area, displays an obvious 

optimal sample unit length of approximately 2 meters (Fig. 5). As units increase in 

length, the performance of ACS at sampling this population decreases steadily. 

Incidentally, Population 5 also had the smallest and least variable nearest neighbor 

distances (Table 1). Populations 3 and 4, also with smaller nearest neighbor distances, 

displayed a similar, if not quite as obvious trend of better performance at smaller sample 

unit lengths (Figs. 6 & 7). In general, ACS appears to perform well at sample unit lengths 

of 2 to 5 meters for all populations.

In general, the ratio of the expected final sample size (E(n*)) with an ACS design 

relative to the initial sample size (n1) increased as the size of the basic sampling unit 

increased and decreased as the initial sampling fraction increased. The pattern exhibited 

by Population 6 (Fig. 8) is typical of the patterns exhibited by the other populations in 

this study with regards to the relative magnitude of the expected final sample size. There 

were no clear relationships between the expected final sample sizes and the relative 

efficiency values for any of the populations.

Some interesting trends were also observed across increasing sampling fractions. 

The efficiency of both ACS estimators increased as initial sampling fraction increased, 

but the RE of the HH estimator showed modest increases at best (Appendix D). On the 

other hand, the HT estimator exhibited extremely dramatic increases in efficiency with 

only modest increases in sampling fraction. For example, the efficiency of the HT 



19

estimator at sampling Population 5 with a sample unit length of 2 meters and condition 

C1 increased 50 fold as initial sampling fraction increased from 0.025 to 0.10 (Appendix 

D, Table 18). This is an extreme example however, as Population 5 contains a “hyper-

network”, a particularly large network that contains a large fraction of the population’s 

individuals. As the initial sampling fraction increases so does the probability of including 

this hyper-network, resulting in very low sampling variances. In addition to this extreme 

example, the HT estimator showed similar trends of taking better advantage of larger 

sample fractions than the SRS estimator in the other populations as well.

When the condition C was made more restrictive, even though it was by the 

smallest degree possible, significant changes in the relative efficiency of the ACS HT 

estimator can be seen in all six populations. For all populations, condition C2 required a 

higher initial sampling fraction for ACS to match the efficiency of SRS. It is important to 

note, however, that the more restrictive condition C2 resulted in final sample sizes being 

20% smaller than under the less restrictive condition C1. The SRS sampling variances 

used in determining the REs under condition C2 were also calculated given these smaller 

sample sizes, but did not exhibit as much of a decrease in precision due to the fact that 

with a more restrictive condition the network sizes in a population will decrease on 

average and the proportion of edge units to network units will increase. This causes the 

proportion of the sample that is explicitly used by the HT estimator to go down, bringing 

precision down as well. Despite the lower performance of the ACS HT estimator under 

the condition C2, the contour plots seen in figures 2-7 still indicate similar optimal sample 

unit sizes.
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Figure 2. Contour plots representing the efficiency of the HT estimator at sampling 
Population 1 (T=74) relative to the SRS estimator given two conditions to include 
additional units in a sample: C1 {i: yi > 0} and C2 {i: yi > 1}. Initial sampling 
fractions range from 0.01 to 0.50 and sample unit edge lengths range from 1 m to 
15 m.

C1

Initial Sampling Fraction (n1/N)

U
ni

t 
E

dg
e 

Le
ng

th
 (

m
)

 1 

 2 

 2 

0.0 0.1 0.2 0.3 0.4 0.5

2
4

6
8

1
0

1
2

1
4

C2

Initial Sampling Fraction (n1/N)

U
ni

t 
E

dg
e 

Le
ng

th
 (

m
)

 1 

0.0 0.1 0.2 0.3 0.4 0.5

2
4

6
8

1
0

1
2

1
4

Figure 3. Contour plots representing the efficiency of the HT estimator at sampling 
Population 2 (T=80) relative to the SRS estimator given two conditions to include 
additional units in a sample: C1 {i: yi > 0} and C2 {i: yi > 1}. Initial sampling 
fractions range from 0.01 to 0.50 and sample unit edge lengths range from 1 m to 
15 m.



21

C1

Initial Sampling Fraction (n1/N)

U
ni

t 
E

dg
e 

Le
ng

th
 (

m
)

 1
 

 2 
 5 

 10 

0.0 0.1 0.2 0.3 0.4 0.5

2
4

6
8

1
0

1
2

1
4

C2

Initial Sampling Fraction (n1/N)

U
ni

t 
E

dg
e 

Le
ng

th
 (

m
)

 1
 

 2 

 5
 

 10 

0.0 0.1 0.2 0.3 0.4 0.5

2
4

6
8

1
0

1
2

1
4

Figure 4. Contour plots representing the efficiency of the HT estimator at sampling 
Population 6 (T=1997) relative to the SRS estimator given two conditions to 
include additional units in a sample: C1 {i: yi > 0} and C2 {i: yi > 1}. Initial 
sampling fractions range from 0.01 to 0.50 and sample unit edge lengths range 
from 1 m to 15 m.
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Figure 5. Contour plots representing the efficiency of the HT estimator at sampling 
Population 5 (T=625) relative to the SRS estimator given two conditions to 
include additional units in a sample: C1 {i: yi > 0} and C2 {i: yi > 1}. Initial 
sampling fractions range from 0.01 to 0.50 and sample unit edge lengths range 
from 1 m to 15 m.
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Figure 6. Contour plots representing the efficiency of the HT estimator at sampling 
Population 3 (T=116) relative to the SRS estimator given two conditions to 
include additional units in a sample: C1 {i: yi > 0} and C2 {i: yi > 1}. Initial 
sampling fractions range from 0.01 to 0.50 and sample unit edge lengths range 
from 1 m to 15 m.

C1

Initial Sampling Fraction (n1/N)

U
ni

t 
E

dg
e 

Le
ng

th
 (

m
)

 1
 

 2 

 5
 

0.0 0.1 0.2 0.3 0.4 0.5

2
4

6
8

1
0

1
2

1
4

C2

Initial Sampling Fraction (n1/N)

U
ni

t 
E

dg
e 

Le
ng

th
 (

m
)

 1
 

 2 

 5
 

0.0 0.1 0.2 0.3 0.4 0.5

2
4

6
8

1
0

1
2

1
4

Figure 7. Contour plots representing the efficiency of the HT estimator at sampling 
Population 4 (T=189) relative to the SRS estimator given two conditions to 
include additional units in a sample: C1 {i: yi > 0} and C2 {i: yi > 1}. Initial 
sampling fractions range from 0.01 to 0.50 and sample unit edge lengths range 
from 1 m to 15 m.
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Figure 8. Contour plot representing the ratio of the expected final sample size 
(E(n*)) to the initial sample size (n1) for an ACS design applied to Population 6 
(T=1997) with a condition to include additional units in a sample of C1 {i: yi > 0}.
Initial sampling fractions range from 0.01 to 0.50 and sample unit edge lengths 
range from 1 m to 15 m.
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DISCUSSION

The efficiency of ACS depends on a number of factors. According to earlier 

work, higher efficiencies result when the final sample size is only slightly larger than the 

initial sample size, as well as when the within-network variance (as opposed to between-

network variance) is a large proportion of the total variance (Smith et al. 1995, Thompson 

& Seber 1996, Brown 2003, Christman 1997). This is difficult to achieve, though, 

because these two circumstances are usually mutually exclusive. What’s more, these 

suggestions are mainly based on the behavior of the Hansen-Hurwitz estimator, and may 

not necessarily hold true for the Horvitz-Thompson estimator. Smith et al. (2004) argued 

that the efficiency of an adaptive cluster sample is a function of the interaction between 

the within-network variance and final sample size and ultimately depends upon the 

spatial distribution of the target population. This study shows that a wide variety of 

populations, at the appropriate scale and given the appropriate condition for adaptive 

expansion of the sample, can be sampled more efficiently with an adaptive cluster sample 

design. The key is to be able to determine what scale, initial sampling fraction, and 

condition to adaptively add units to the sample is suitable. 

The results of this study also indicate that there should be no question that the HT 

estimator is superior to the HH estimator for use in an ACS setting. Although the HH 

estimator uses the adaptively added units to adjust the values of the initially sampled 

units to network means, it does not explicitly incorporate any of these additional unit 

values directly into the estimate. With calculators such as that presented in Appendix B, 
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ease of use should no longer be an issue regarding the application of the HT estimator to 

an ACS design. 

The choice of the condition, C, to include additional units in a sample is difficult. 

A less restrictive condition will result in a higher proportion of the population to be 

sampled, but can result in a final sample size that is much larger than the initial sample 

and more costly to implement. At the same time, it can also result in the within-network 

variance being a high fraction of the total variance, which will increase the efficiency of 

the adaptive cluster sample and provide highly precise estimates. In a simulation study, 

Brown (2003) found that a less restrictive condition did indeed result in high relative 

efficiencies for some populations, but only those with low total abundances. A highly 

restrictive condition will result in lower final sample sizes and less empty edge units 

being sampled, but for some populations it may result in little additional information 

being added to the sample and the full benefit of an adaptive cluster design may be lost. 

However, for populations that seem not to exhibit the appropriate level of geographical 

rarity for the practical implementation of ACS, the choice of a restrictive condition can 

result in geographically rare networks that will add information and precision to the 

sample without the danger of an exorbitant final sample size. This study showed that 

even the smallest change in the condition to adaptively add units to the sample can have 

strong effects on both the efficiency of ACS and the final size of the sample. Ultimately 

the choice of all design parameters, but especially the choice of condition C, will have to 

be made in the context of time, resources, and other issues.
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The reaction of the HT estimator to increasing sample size has implications for 

sample budgeting. If a small increase in the initial sample can double or triple the 

precision of the estimates it returns, larger sampling budgets may be much more 

justifiable. However, a close examination of the tables in Appendix D shows that the 

response of the HT estimator to increasing sample sizes can vary in magnitude quite a bit 

between grid cell sizes that are very similar. A decision regarding the initial sampling 

fraction should not be made without carefully considering the size of the basic sampling 

unit at the same time.

Very few studies have ever examined the effects of sample unit size on the 

performance of ACS. Simulation studies like those done by Christman (1997), and 

Brown (2003) examine a wide range of other design parameters but did not actually 

examine the effect of sample unit size, even though they acknowledge its likely 

importance. In Phillipi’s (2005) application of ACS to some small plant populations, he 

used just two sample unit sizes, the larger of which was a multiple of the smaller. He 

found that while different final sample sizes resulted, there was no difference in 

precision. The results of this study, which examined a far greater range of sample unit 

sizes than any previous study, show that sample unit size can have as much if not more of 

an impact on the performance of ACS than other design parameters. The question of how 

to determine the optimal sample unit size is a difficult one, especially from limited pre-

sample information. For the populations examined in this study, average nearest neighbor 

distances tended to be smaller than sample unit lengths indicated as optimal by the RE 

contour plots (Figs, 2-7). Until more research is done, a tentative guideline is to scale the 
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sample units so they are at least larger than the average nearest neighbor distance. 

Unfortunately, obtaining a reliable estimate of average nearest neighbor distance may be 

just as much of a problem as estimating a population’s total abundance.

The findings of this study reveal that ACS estimates of abundance have a 

sensitivity to design parameters, such as sample unit size, that has not yet received 

enough attention to be fully understood. Unfortunately, given the impact these design 

parameters can have on the efficiency of a sample, it will be very difficult to ever define a 

rule for constructing an optimal adaptive cluster sample because the effects of the design 

parameters on an ACS estimator’s performance within a grid-based setting depends on 

the specific point distribution of individuals across the sample space, the knowledge of 

which is always incomplete prior to performing a sample. This raises the question of 

whether information from previous studies or preliminary surveys can be effectively used 

to optimize ACS parameters, and to what degree the procedures introduced here can be 

utilized to that aim. With further research and the development of software applications, 

future researchers could not only be able to compare a range of design parameters, but 

also a range of different designs at the same time. This may be done not only with fully 

mapped populations, but with simulated populations based upon population distribution 

characteristics derived from sample data as well. Monitoring activities especially have the 

potential to be improved through the use of these procedures. Researchers will be well 

positioned to make use of data from preceding years to compare a wide variety of design 

parameters. Sampling procedures could be adjusted and refined, potentially resulting in 

considerably reduced sampling costs with equal or even more precise estimates of 
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abundance. Through the innovative use of tools such as Geographic Information Systems, 

flexible sampling designs like ACS may no longer be seen as overly complicated or 

intimidating. Instead, the very flexibility that has at times made ACS difficult to 

implement effectively could now allow this design to be tailored to many diverse 

sampling situations, and the use of this and other such adaptive designs may expand.
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APPENDIX A

GIS procedures using ArcGIS 9.1

1. Download and install HawthTools (Beyer 2004) available free at 
http://www.spatialecology.com/htools

2. Make sure point X,Y coordinates saved as a dbase file (.dbf) with separate, labeled 
columns for the X and Y values. Import into ArcGIS using <Add Data>

3. Data Management Tools -> Fields -> Calculate Fields
Select the coordinate dbase file from step 2 as the Input Table.
Select the X-coordinate column label as the Field Name.
Write expression to add a value less than the data’s level of precision.
Repeat for Y-coordinate.

4. Tools -> Add XY Data
Creates a point distribution using the XY data.

5. HawthTools -> Sampling Tools -> Create Vector Grid
Set the extent to the dimensions of the study area.
Set the spacing between lines to the desired sample unit length.
Set the output as a polygon layer.
Output is a grid polygon layer.

6. HawthTools-> Analysis Tools -> Count Points in Polygons
Adds PNTPOLYCNT field to the attribute table of a grid polygon layer.

7. ArcToolbox -> Conversion Tools -> To Raster -> Feature to Raster
The input is a grid polygon layer.
Set the field as PNTPOLYCNT.
Output is a density raster layer.

Open attribute table -> Options -> Export
The fields Value and Count correspond to vectors “yi” and “count” in 
the Simple Random Sampling Variance Calculator (Appendix B).

8. ArcToolbox -> Spatial Analyst Tools -> Reclassify
For values in a density raster not satisfying C, reclassify to “no data”
For all other values reclassify to 1
Output is a network raster layer.
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9. ArcToolbox -> Conversion Tools -> from Raster -> Raster to Polygon
The input is a network raster.
Make sure “simplify polygons” is deselected.
Output is a network polygon layer.

10. HawthTools-> Table Tools -> Add AREA/PERIMETER Fields to Table
The input is a network polygon layer.
Convert Area by the decimal equivalent of 1/(sample unit length2)
Convert Perimeter by the decimal equivalent of 1/(sample unit length)

Open attribute table -> Options -> Export
The fields AREA and PERIMETER correspond to vectors “mk” and “ak”

in the Final Sample Size Calculator (Appendix B).

* For the condition C {i: yi > 0}, proceed to step 10 and then stop. For all other more 
restrictive conditions, skip to step 11.

11. HawthTools-> Analysis Tools -> Count Points in Polygons
Adds PNTPOLYCNT field to the attribute table of a network polygon layer.

Open attribute table -> Options -> Export
The fields AREA and PNTPOLYCNT correspond to vectors “mk” and 

“yk” in the Horvitz-Thompson Variance Calculator and the 
Hansen-Hurwitz Variance Calculator (Appendix B).

12. ArcToolbox -> Analysis Tools -> Extract -> Select
Write SQL expression to select all values that fail to satisfy the condition C.
Output is a polygon layer of occupied units that lead no further sampling.

13. ArcToolbox -> Analysis Tools -> Overlay -> Union
Inputs are a polygon layer of occupied units that lead no further sampling and a 

network polygon layer.
Output is a polygon layer of unique networks.

14. HawthTools-> Analysis Tools -> Count Points in Polygons
Adds PNTPOLYCNT field to the attribute table of a polygon layer of unique 
networks.

Open attribute table -> Options -> Export
The fields AREA and PNTPOLYCNT correspond to vectors “mk” and 

“yk” in the Horvitz-Thompson Variance Calculator and the 
Hansen-Hurwitz Variance Calculator (Appendix B).
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APPENDIX B

R Functions

The Horvitz-Thompson Variance Calculator

#This function calculates the sampling variance of the Horvitz-Thompson estimator of #total abundance in 
an Adaptive Cluster Sampling design.

#Arguments:
# data: list created by using the read.dbf function on the exported attribute
# table of the network polygon layer from Appendix A
# N:  total units in population
# sampfrac: vector of sampling fractions (n/N) to be selected from N
# mk: vector of total units that comprise each network k in the population
# yk: vector of total y-values in each network k

var_tau_ht<-function(N,sampfrac,data)
{

mk<-data[["AREA"]]
yk<-data[["PNTPOLYCNT"]]
varht<-function(N,n,mk,yk)
{

ck<-exp(lfactorial(N-mk)-lfactorial(N-mk-n)-lfactorial(N)+lfactorial(N-n))
mkh<-colSums(combn(mk,2))
ckh<-exp(lfactorial(N-mkh)-lfactorial(N-mkh-n)-lfactorial(N)+lfactorial(N-n))
alphak<-1-ck
cknh<-colSums(combn(ck,2))
alphakh<-1-(cknh-ckh)
yxy<-combn(yk,2)
yprod<-(yxy[1,])*(yxy[2,])
alphaxalpha<-combn(alphak,2)
alphaprod<-(alphaxalpha[1,])*(alphaxalpha[2,])
alphasqr<-alphak*alphak
ysqr<-yk*yk
vtermkh<-yprod*(alphakh-alphaprod)/alphaprod
vtermkk<-ysqr*(alphak-alphasqr)/alphasqr
varterms<-c(vtermkh,vtermkk)
var<-(sum(varterms))
var

}
sampsize<-(N*sampfrac)
for(n in sampsize)print(varht(N,n,mk,yk))

}
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The Hansen-Hurwitz Variance Calculator

#This function calculates the variance of the Hansen-Hurwitz estimator of total abundance in an Adaptive 
#Cluster Sampling design.

#Arguments:
# data: list created by using the read.dbf function on the exported attribute table of the
# network polygon layer from Appendix A
# N: total units in population
# sampfrac: vector of sampling fractions (n/N) to be selected from N
# mk: vector of total units that comprise each network k in the population
# yk: vector of total y-values in each network k

var_tau_hh<-function(N,sampfrac,data)
{

mk<-data[["AREA"]]
yk<-data[["PNTPOLYCNT"]]
var_hh<-function(N,n,mk,yk)
{

wi<-yk/mk
mu<-(sum(yk))/N
ss<-sum(((wi-mu)^2)*mk)
emptyss<-((0-mu)^2)*(N-(sum(mk)))
c<-(N*(N-n))/(n*(N-1))
var<-c*(ss+emptyss)
var

}
sampsize<-(N*sampfrac)
for(n in sampsize)print(var_hh(N,n,mk,yk))

}
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The Final Sample Size Calculator

#This function calculates the expected final sample size under an Adaptive Cluster Sampling design.

#Arguments:
# data: list created by using the read.dbf function on the exported attribute table of the
# network polygon layer from Appendix A
# N: total units in population
# sampfrac: vector of sampling fractions (n/N) to be selected from N
# mk: vector of total units that comprise each network k in the population
# ak: vector of total edge units for each network k

exp_fin_n<-function(N,sampfrac,data)
{

mk<-data[["AREA"]]
ak<-data[["PERIMETER"]]
nstar<-function(N,n,mk,ak)
{

edgepi<-(ak)*(1-(exp(lfactorial(N-1-mk)-lfactorial(N-1-mk-n)-lfactorial(N)+lfactorial(N-n))))
netpi<-(mk)*(1-(exp(lfactorial(N-mk)-lfactorial(N-mk-n)-lfactorial(N)+lfactorial(N-n))))
netandedge<-c(mk,ak)
others<-(N-sum(netandedge))
otherpi<-(others)*(1-(exp(lfactorial(N-1)-lfactorial(N-1-n)-lfactorial(N)+lfactorial(N-n))))
nfinal<-sum(edgepi,netpi,otherpi)
nfinal

}
sampsize<-(N*sampfrac)
for(n in sampsize)print(nstar(N,n,mk,ak))

}
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The Simple Random Sampling Variance Calculator

#This function calculates the variance of the Simple Random Sample estimator of total abundance in an 
#Adaptive Cluster Sampling design.

#Arguments:
# data: list created by using the read.dbf function on the exported attribute table of the
# density raster layer from Appendix A
# N: total units in sample universe
# sampsize: vector of sampling sizes from the output of the Final Sample Size calculator
# yi: value vector for the yi values in a population
# count: frequency vector for the yi values in a population

>var_t_srs<-function(sampsize,data)
{

yi<-data[["Value"]]
count<-data[["Count"]]
srsvar<-function(n,yi,count)
{

N<-sum(count)
total<-sum(yi*count)
mu<-(total/N)
popvar<-(sum(((yi-mu)^2)*count))/(N-1)
srsvar<-(N-n)*(N/n)*popvar
srsvar

}
for(n in sampsize)print(srsvar(n,yi,count))

}
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APPENDIX C

Point Distribution Maps

Figure 9. Point distribution of Population 1 (74 individuals in a 15,525 m2 area). A 
grid with unit lengths of 5 meters has been overlaid to provide scale.
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Figure 10. Point distribution of Population 2 (80 individuals in a 9,600 m2 area). A 
grid with unit lengths of 5 meters has been overlaid to provide scale.

Figure 11. Point distribution of Population 3 (116 individuals in a 9,100 m2 area). A 
grid with unit lengths of 5 meters has been overlaid to provide scale.
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Figure 12. Point distribution of Population 4 (189 individuals in a 9,100 m2 area). A 
grid with unit lengths of 5 meters has been overlaid to provide scale.

Figure 13. Point distribution of Population 5 (625 individuals in a 6000 m2 area). A 
grid with unit lengths of 5 meters has been overlaid to provide scale.



41

Figure 14. Point distribution of Population 6 (1,997 individuals in a 220,400 m2 area). 
A grid with unit lengths of 15 meters has been overlaid to provide scale.
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APPENDIX D

Relative Efficiency Tables

Population 1

Table 2. The relative efficiency of the ACS HT estimator to the SRS estimator of the 
total for Population 1 (T=74, Area= 15525 m2) with sample unit lengths ranging 
from 1 m to 15 m and initial sampling fractions ranging from 0.01 to 0.50. The 
condition to include additional units in a sample is C1 {i: yi > 0}.

n1 / N
Sample Unit Length (m)

1 2 3 4 5 7.5 10 12.5 15

0.010 1.00 0.99 0.78 0.61 0.48 0.24 0.20 0.24 0.15

0.025 1.00 0.99 0.80 0.68 0.52 0.30 0.24 0.27 0.17

0.050 1.01 1.01 0.83 0.81 0.59 0.43 0.33 0.35 0.23

0.075 1.02 1.02 0.87 0.96 0.67 0.62 0.46 0.45 0.33

0.100 1.03 1.03 0.90 1.12 0.76 0.88 0.62 0.58 0.49

0.125 1.03 1.05 0.94 1.29 0.87 1.22 0.82 0.76 0.75

0.150 1.04 1.06 0.97 1.45 1.00 1.64 1.05 0.98 1.17

0.200 1.06 1.09 1.04 1.76 1.32 2.61 1.52 1.54 2.75

0.250 1.08 1.13 1.11 2.02 1.74 3.57 1.95 2.20 5.50

0.500 1.21 1.36 1.44 3.06 5.03 7.63 3.94 5.41 13.37

Table 3. The relative efficiency of the ACS HT estimator to the SRS estimator of the 
total for Population 1 (T=74, Area= 15525 m2) with sample unit lengths ranging 
from 1 m to 15 m and initial sampling fractions ranging from 0.01 to 0.50. The 
condition to include additional units in a sample is C2 {i: yi > 1}.

n1 / N
Sample Unit Length (m)

1 2 3 4 5 7.5 10 12.5 15

0.010 1.00 0.98 0.95 0.91 0.72 0.54 0.24 0.25 0.22

0.025 1.00 0.98 0.95 0.92 0.74 0.57 0.27 0.27 0.24

0.050 1.00 0.98 0.95 0.94 0.78 0.63 0.34 0.33 0.28

0.075 1.00 0.98 0.95 0.96 0.82 0.69 0.43 0.40 0.34

0.100 1.00 0.98 0.96 0.98 0.86 0.77 0.54 0.49 0.42

0.125 1.00 0.98 0.96 1.00 0.90 0.84 0.67 0.60 0.52

0.150 1.00 0.98 0.96 1.02 0.94 0.93 0.82 0.74 0.66

0.200 1.00 0.98 0.97 1.06 1.03 1.12 1.15 1.10 1.08

0.250 1.00 0.98 0.97 1.10 1.12 1.33 1.48 1.53 1.78

0.500 1.00 0.98 1.01 1.36 1.53 2.51 2.67 3.54 8.63
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Table 4. The relative efficiency of the ACS HH estimator to the SRS estimator of the 
total for Population 1 (T=74, Area= 15525 m2) with sample unit lengths ranging 
from 1 m to 15 m and initial sampling fractions ranging from 0.01 to 0.50. The 
condition to include additional units in a sample is C1 {i: yi > 0}.

n1 / N
Sample Unit Length (m)

1 2 3 4 5 7.5 10 12.5 15

0.010 1.00 0.99 0.78 0.59 0.48 0.23 0.20 0.25 0.15

0.025 1.00 0.99 0.79 0.62 0.49 0.25 0.21 0.25 0.15

0.050 1.00 0.99 0.80 0.66 0.51 0.28 0.24 0.27 0.16

0.075 1.00 0.99 0.81 0.69 0.53 0.31 0.26 0.29 0.17

0.100 1.00 0.99 0.82 0.73 0.54 0.35 0.30 0.31 0.18

0.125 1.00 0.99 0.83 0.76 0.56 0.39 0.33 0.33 0.20

0.150 1.00 0.99 0.83 0.78 0.58 0.42 0.36 0.35 0.22

0.200 1.00 1.00 0.85 0.83 0.61 0.48 0.42 0.40 0.26

0.250 1.00 1.00 0.86 0.86 0.64 0.54 0.47 0.45 0.29

0.500 1.00 1.01 0.90 0.95 0.77 0.72 0.64 0.60 0.44

Table 5. The relative efficiency of the ACS HH estimator to the SRS estimator of the 
total for Population 1 (T=74, Area= 15525 m2) with sample unit lengths ranging 
from 1 m to 15 m and initial sampling fractions ranging from 0.01 to 0.50. The 
condition to include additional units in a sample is C2 {i: yi > 1}.

n1 / N
Sample Unit Length (m)

1 2 3 4 5 7.5 10 12.5 15

0.010 1.00 0.99 0.96 0.92 0.73 0.55 0.24 0.26 0.23

0.025 1.00 0.99 0.96 0.93 0.74 0.56 0.25 0.26 0.23

0.050 1.00 0.99 0.96 0.93 0.75 0.58 0.27 0.27 0.24

0.075 1.00 0.99 0.96 0.93 0.76 0.59 0.30 0.29 0.25

0.100 1.00 0.99 0.96 0.93 0.77 0.61 0.32 0.31 0.26

0.125 1.00 0.99 0.96 0.94 0.78 0.62 0.35 0.33 0.27

0.150 1.00 0.99 0.96 0.94 0.79 0.64 0.38 0.35 0.28

0.200 1.00 0.99 0.96 0.94 0.81 0.67 0.43 0.39 0.31

0.250 1.00 0.99 0.96 0.95 0.82 0.69 0.48 0.44 0.35

0.500 1.00 0.99 0.96 0.96 0.87 0.79 0.66 0.62 0.49
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Population 2

Table 6. The relative efficiency of the ACS HT estimator to the SRS estimator of the 
total for Population 2 (T=80, Area= 9600 m2) with sample unit lengths ranging 
from 1 m to 15 m and initial sampling fractions ranging from 0.01 to 0.50. The 
condition to include additional units in a sample is C1 {i: yi > 0}.

n1 / N
Sample Unit Length (m)

1 2 3 4 5 7.5 10 12.5 15

0.010 0.97 0.91 0.72 0.57 0.56 0.37 0.13 0.15 0.15

0.025 0.98 0.91 0.75 0.59 0.58 0.39 0.14 0.17 0.16

0.050 0.98 0.93 0.80 0.64 0.62 0.43 0.17 0.20 0.18

0.075 0.98 0.94 0.85 0.69 0.66 0.48 0.21 0.26 0.22

0.100 0.99 0.96 0.90 0.75 0.71 0.53 0.27 0.35 0.26

0.125 0.99 0.97 0.96 0.81 0.76 0.60 0.36 0.47 0.33

0.150 0.99 0.99 1.02 0.87 0.82 0.68 0.47 0.62 0.41

0.200 1.00 1.02 1.15 1.00 0.95 0.89 0.88 0.98 0.64

0.250 1.01 1.06 1.31 1.13 1.11 1.18 1.66 1.34 0.94

0.500 1.06 1.28 2.37 1.84 2.44 4.18 31.78 2.37 1.92

Table 7. The relative efficiency of the ACS HT estimator to the SRS estimator of the 
total for Population 2 (T=80, Area= 9600 m2) with sample unit lengths ranging 
from 1 m to 15 m and initial sampling fractions ranging from 0.01 to 0.50. The 
condition to include additional units in a sample is C2 {i: yi > 1}.

n1 / N
Sample Unit Length (m)

1 2 3 4 5 7.5 10 12.5 15

0.010 0.99 0.98 0.91 0.80 0.72 0.52 0.26 0.36 0.37

0.025 0.99 0.98 0.92 0.81 0.74 0.53 0.26 0.37 0.38

0.050 0.99 0.98 0.94 0.83 0.76 0.54 0.28 0.38 0.39

0.075 0.99 0.98 0.96 0.85 0.79 0.56 0.30 0.39 0.41

0.100 0.99 0.99 0.98 0.87 0.82 0.58 0.32 0.41 0.42

0.125 0.99 0.99 0.99 0.89 0.85 0.60 0.34 0.42 0.44

0.150 0.99 0.99 1.01 0.92 0.88 0.62 0.37 0.44 0.46

0.200 0.99 0.99 1.05 0.96 0.95 0.67 0.44 0.48 0.52

0.250 0.99 1.00 1.09 1.00 1.03 0.72 0.54 0.53 0.58

0.500 0.99 1.02 1.32 1.22 1.51 1.04 1.94 0.89 1.40



45

Table 8. The relative efficiency of the ACS HH estimator to the SRS estimator of the 
total for Population 2 (T=80, Area= 9600 m2) with sample unit lengths ranging 
from 1 m to 15 m and initial sampling fractions ranging from 0.01 to 0.50. The 
condition to include additional units in a sample is C1 {i: yi > 0}.

n1 / N
Sample Unit Length (m)

1 2 3 4 5 7.5 10 12.5 15

0.010 0.97 0.91 0.73 0.57 0.57 0.39 0.14 0.16 0.16

0.025 0.97 0.91 0.73 0.58 0.58 0.39 0.14 0.15 0.16

0.050 0.97 0.91 0.74 0.60 0.58 0.39 0.14 0.15 0.15

0.075 0.98 0.92 0.75 0.62 0.59 0.40 0.14 0.16 0.15

0.100 0.98 0.92 0.76 0.64 0.60 0.40 0.14 0.17 0.15

0.125 0.98 0.92 0.77 0.65 0.61 0.41 0.15 0.18 0.15

0.150 0.98 0.92 0.78 0.67 0.62 0.42 0.16 0.20 0.16

0.200 0.98 0.93 0.80 0.70 0.63 0.44 0.17 0.23 0.17

0.250 0.98 0.93 0.82 0.73 0.65 0.46 0.20 0.28 0.19

0.500 0.98 0.95 0.90 0.83 0.74 0.59 0.31 0.45 0.30

Table 9. The relative efficiency of the ACS HH estimator to the SRS estimator of the 
total for Population 2 (T=80, Area= 9600 m2) with sample unit lengths ranging 
from 1 m to 15 m and initial sampling fractions ranging from 0.01 to 0.50. The 
condition to include additional units in a sample is C2 {i: yi > 1}.

n1 / N
Sample Unit Length (m)

1 2 3 4 5 7.5 10 12.5 15

0.010 1.00 0.99 0.93 0.82 0.74 0.54 0.28 0.39 0.41

0.025 1.00 0.99 0.93 0.82 0.75 0.54 0.28 0.39 0.40

0.050 1.00 0.99 0.93 0.83 0.75 0.55 0.27 0.39 0.40

0.075 1.00 0.99 0.93 0.83 0.76 0.55 0.27 0.39 0.40

0.100 1.00 0.99 0.94 0.84 0.77 0.56 0.27 0.39 0.39

0.125 1.00 0.99 0.94 0.84 0.77 0.56 0.27 0.39 0.39

0.150 1.00 0.99 0.94 0.85 0.78 0.57 0.27 0.40 0.39

0.200 1.00 0.99 0.95 0.86 0.79 0.58 0.28 0.40 0.39

0.250 1.00 0.99 0.95 0.86 0.80 0.59 0.29 0.41 0.39

0.500 1.00 0.99 0.97 0.90 0.85 0.65 0.35 0.48 0.43
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Population 3

Table 10. The relative efficiency of the ACS HT estimator to the SRS estimator of the 
total for Population 3 (T=116, Area= 9100 m2) with sample unit lengths ranging 
from 1 m to 15 m and initial sampling fractions ranging from 0.01 to 0.50. The 
condition to include additional units in a sample is C1 {i: yi > 0}.

n1 / N
Sample Unit Length (m)

1 2 3 4 5 7.5 10 12.5 15

0.010 1.00 0.76 0.50 0.28 0.23 0.32 0.28 0.27 0.46

0.025 1.00 0.79 0.56 0.36 0.28 0.36 0.30 0.29 0.47

0.050 1.01 0.85 0.67 0.56 0.41 0.44 0.34 0.32 0.50

0.075 1.02 0.90 0.80 0.89 0.61 0.55 0.40 0.35 0.53

0.100 1.03 0.97 0.95 1.41 0.91 0.71 0.48 0.40 0.57

0.125 1.04 1.04 1.12 2.22 1.36 0.93 0.59 0.46 0.61

0.150 1.05 1.11 1.30 3.41 2.02 1.23 0.74 0.55 0.67

0.200 1.07 1.26 1.68 7.16 4.27 2.21 1.23 0.80 0.83

0.250 1.10 1.43 2.06 12.08 8.04 4.09 2.17 1.26 1.08

0.500 1.26 2.34 3.69 24.39 27.46 73.84 82.47 30.86 8.55

Table 11. The relative efficiency of the ACS HT estimator to the SRS estimator of the 
total for Population 3 (T=116, Area= 9100 m2) with sample unit lengths ranging 
from 1 m to 15 m and initial sampling fractions ranging from 0.01 to 0.50. The 
condition to include additional units in a sample is C2 {i: yi > 1}.

n1 / N
Sample Unit Length (m)

1 2 3 4 5 7.5 10 12.5 15

0.010 0.99 0.94 0.78 0.60 0.36 0.44 0.33 0.34 0.52

0.025 0.99 0.94 0.80 0.63 0.39 0.47 0.35 0.36 0.54

0.050 0.99 0.95 0.84 0.69 0.46 0.54 0.40 0.39 0.56

0.075 0.99 0.95 0.87 0.76 0.55 0.61 0.46 0.42 0.59

0.100 0.99 0.96 0.90 0.84 0.65 0.70 0.53 0.46 0.63

0.125 0.99 0.97 0.94 0.92 0.78 0.81 0.62 0.51 0.66

0.150 0.99 0.98 0.98 1.01 0.92 0.92 0.74 0.57 0.71

0.200 0.99 0.99 1.05 1.22 1.25 1.22 1.08 0.73 0.81

0.250 0.99 1.01 1.12 1.46 1.63 1.58 1.63 0.97 0.94

0.500 0.99 1.09 1.45 2.89 3.02 4.31 18.93 6.68 2.47
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Table 12. The relative efficiency of the ACS HH estimator to the SRS estimator of the 
total for Population 3 (T=116, Area= 9100 m2) with sample unit lengths ranging 
from 1 m to 15 m and initial sampling fractions ranging from 0.01 to 0.50. The 
condition to include additional units in a sample is C1 {i: yi > 0}.

n1 / N
Sample Unit Length (m)

1 2 3 4 5 7.5 10 12.5 15

0.010 1.00 0.76 0.49 0.26 0.22 0.32 0.29 0.29 0.50

0.025 1.00 0.76 0.51 0.28 0.24 0.33 0.29 0.29 0.49

0.050 1.00 0.78 0.55 0.33 0.27 0.35 0.29 0.29 0.48

0.075 1.00 0.79 0.58 0.38 0.30 0.36 0.30 0.28 0.47

0.100 1.00 0.81 0.62 0.42 0.33 0.39 0.30 0.28 0.46

0.125 1.00 0.82 0.65 0.47 0.37 0.41 0.31 0.28 0.46

0.150 1.00 0.83 0.68 0.52 0.40 0.44 0.33 0.29 0.45

0.200 1.00 0.85 0.73 0.60 0.47 0.50 0.36 0.30 0.45

0.250 1.00 0.88 0.78 0.67 0.53 0.55 0.39 0.32 0.45

0.500 1.01 0.95 0.92 0.88 0.72 0.80 0.60 0.47 0.56

Table 13. The relative efficiency of the ACS HH estimator to the SRS estimator of the 
total for Population 3 (T=116, Area= 9100 m2) with sample unit lengths ranging 
from 1 m to 15 m and initial sampling fractions ranging from 0.01 to 0.50. The 
condition to include additional units in a sample is C2 {i: yi > 1}.

n1 / N
Sample Unit Length (m)

1 2 3 4 5 7.5 10 12.5 15

0.010 0.99 0.95 0.79 0.60 0.36 0.45 0.35 0.36 0.55

0.025 0.99 0.95 0.80 0.61 0.37 0.46 0.35 0.37 0.55

0.050 0.99 0.95 0.81 0.63 0.39 0.48 0.35 0.37 0.56

0.075 0.99 0.95 0.82 0.65 0.42 0.50 0.36 0.37 0.56

0.100 0.99 0.95 0.82 0.66 0.44 0.52 0.37 0.38 0.56

0.125 0.99 0.95 0.83 0.68 0.47 0.54 0.39 0.38 0.56

0.150 0.99 0.95 0.84 0.69 0.49 0.56 0.40 0.39 0.57

0.200 0.99 0.95 0.85 0.72 0.54 0.61 0.43 0.40 0.58

0.250 0.99 0.96 0.87 0.75 0.58 0.65 0.47 0.42 0.60

0.500 0.99 0.96 0.91 0.84 0.74 0.83 0.66 0.56 0.70
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Population 4

Table 14. The relative efficiency of the ACS HT estimator to the SRS estimator of the 
total for Population 4 (T=189, Area= 9100 m2) with sample unit lengths ranging 
from 1 m to 15 m and initial sampling fractions ranging from 0.01 to 0.50. The 
condition to include additional units in a sample is C1 {i: yi > 0}.

n1 / N
Sample Unit Length (m)

1 2 3 4 5 7.5 10 12.5 15

0.010 1.01 0.60 0.35 0.30 0.27 0.30 0.28 0.34 0.46

0.025 1.03 0.68 0.40 0.37 0.33 0.34 0.30 0.35 0.48

0.050 1.08 0.83 0.51 0.51 0.48 0.41 0.35 0.39 0.50

0.075 1.12 0.98 0.63 0.70 0.70 0.51 0.41 0.43 0.54

0.100 1.16 1.12 0.76 0.91 1.01 0.65 0.50 0.49 0.58

0.125 1.20 1.26 0.90 1.14 1.45 0.84 0.63 0.57 0.63

0.150 1.25 1.39 1.03 1.38 2.05 1.10 0.80 0.67 0.70

0.200 1.33 1.62 1.28 1.84 3.74 1.90 1.35 0.99 0.91

0.250 1.42 1.84 1.48 2.24 5.92 3.27 2.44 1.56 1.25

0.500 1.79 2.84 2.27 4.15 12.17 14.07 101.16 44.24 16.78

Table 15. The relative efficiency of the ACS HT estimator to the SRS estimator of the 
total for Population 4 (T=189, Area= 9100 m2) with sample unit lengths ranging 
from 1 m to 15 m and initial sampling fractions ranging from 0.01 to 0.50. The 
condition to include additional units in a sample is C2 {i: yi > 1}.

n1 / N
Sample Unit Length (m)

1 2 3 4 5 7.5 10 12.5 15

0.010 1.01 0.96 0.59 0.56 0.36 0.32 0.33 0.40 0.47

0.025 1.01 0.98 0.64 0.61 0.42 0.35 0.35 0.42 0.48

0.050 1.02 1.01 0.71 0.71 0.55 0.43 0.39 0.45 0.51

0.075 1.02 1.04 0.80 0.82 0.73 0.52 0.43 0.49 0.54

0.100 1.03 1.07 0.89 0.94 0.98 0.65 0.49 0.55 0.57

0.125 1.04 1.10 0.98 1.07 1.31 0.82 0.57 0.61 0.61

0.150 1.04 1.14 1.07 1.22 1.76 1.04 0.66 0.69 0.66

0.200 1.05 1.21 1.25 1.53 3.09 1.72 0.92 0.91 0.80

0.250 1.07 1.29 1.42 1.87 4.98 2.88 1.33 1.26 0.99

0.500 1.14 1.72 2.03 3.84 12.03 14.33 14.23 12.73 4.92
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Table 16. The relative efficiency of the ACS HH estimator to the SRS estimator of the 
total for Population 4 (T=189, Area= 9100 m2) with sample unit lengths ranging 
from 1 m to 15 m and initial sampling fractions ranging from 0.01 to 0.50. The 
condition to include additional units in a sample is C1 {i: yi > 0}.

n1 / N
Sample Unit Length (m)

1 2 3 4 5 7.5 10 12.5 15

0.010 1.00 0.58 0.34 0.30 0.26 0.31 0.29 0.36 0.51

0.025 1.01 0.62 0.36 0.33 0.28 0.32 0.29 0.36 0.50

0.050 1.01 0.67 0.41 0.38 0.33 0.33 0.30 0.35 0.48

0.075 1.02 0.72 0.45 0.44 0.37 0.35 0.30 0.35 0.47

0.100 1.02 0.76 0.49 0.50 0.43 0.37 0.31 0.34 0.45

0.125 1.03 0.79 0.53 0.56 0.48 0.39 0.33 0.35 0.44

0.150 1.03 0.82 0.57 0.61 0.53 0.42 0.34 0.35 0.43

0.200 1.04 0.87 0.63 0.70 0.62 0.48 0.38 0.37 0.43

0.250 1.04 0.90 0.69 0.77 0.71 0.54 0.43 0.40 0.43

0.500 1.06 1.01 0.85 0.98 1.00 0.79 0.67 0.60 0.55

Table 17. The relative efficiency of the ACS HH estimator to the SRS estimator of the 
total for Population 4 (T=189, Area= 9100 m2) with sample unit lengths ranging 
from 1 m to 15 m and initial sampling fractions ranging from 0.01 to 0.50. The 
condition to include additional units in a sample is C2 {i: yi > 1}.

n1 / N
Sample Unit Length (m)

1 2 3 4 5 7.5 10 12.5 15

0.010 1.01 0.96 0.59 0.56 0.35 0.33 0.34 0.42 0.51

0.025 1.02 0.97 0.60 0.58 0.37 0.33 0.34 0.42 0.50

0.050 1.02 0.97 0.63 0.61 0.41 0.35 0.35 0.42 0.50

0.075 1.02 0.97 0.66 0.64 0.44 0.37 0.35 0.42 0.49

0.100 1.02 0.98 0.68 0.67 0.49 0.39 0.36 0.42 0.49

0.125 1.02 0.98 0.71 0.70 0.53 0.41 0.38 0.43 0.49

0.150 1.02 0.99 0.73 0.72 0.58 0.44 0.39 0.44 0.49

0.200 1.02 1.00 0.77 0.77 0.66 0.49 0.42 0.45 0.50

0.250 1.02 1.00 0.80 0.82 0.74 0.55 0.45 0.48 0.51

0.500 1.02 1.03 0.89 0.97 1.02 0.80 0.65 0.65 0.65
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Population 5

Table 18. The relative efficiency of the ACS HT estimator to the SRS estimator of the 
total for Population 5 (T=625, Area= 6000 m2) with sample unit lengths ranging 
from 1 m to 15 m and initial sampling fractions ranging from 0.01 to 0.50. The 
condition to include additional units in a sample is C1 {i: yi > 0}.

n1 / N
Sample Unit Length (m)

1 2 3 4 5 7.5 10 12.5 15

0.010 0.70 0.38 0.46 0.46 0.35 0.42 0.32 0.59 0.49

0.025 0.86 1.02 0.79 0.62 0.42 0.45 0.33 0.60 0.50

0.050 1.15 5.37 2.02 1.05 0.60 0.53 0.36 0.62 0.52

0.075 1.44 22.76 5.30 1.84 0.89 0.62 0.40 0.65 0.54

0.100 1.69 53.22 13.91 3.32 1.35 0.76 0.44 0.68 0.57

0.125 1.89 72.56 34.17 6.14 2.11 0.94 0.50 0.72 0.59

0.150 2.05 81.74 70.75 11.59 3.38 1.19 0.57 0.78 0.63

0.200 2.30 92.68 146.17 42.38 9.37 2.02 0.79 0.92 0.72

0.250 2.51 100.80 180.94 137.40 28.30 3.70 1.15 1.15 0.84

0.500 3.57 126.78 279.84 759.96 1562.27 249.25 21.00 7.93 3.32

Table 19. The relative efficiency of the ACS HT estimator to the SRS estimator of the 
total for Population 5 (T=625, Area= 6000 m2) with sample unit lengths ranging 
from 1 m to 15 m and initial sampling fractions ranging from 0.01 to 0.50. The 
condition to include additional units in a sample is C2 {i: yi > 1}.

n1 / N
Sample Unit Length (m)

1 2 3 4 5 7.5 10 12.5 15

0.010 0.80 0.43 0.48 0.49 0.43 0.52 0.34 0.72 0.57

0.025 0.92 0.90 0.79 0.64 0.51 0.56 0.36 0.74 0.58

0.050 1.14 3.05 1.89 1.03 0.69 0.65 0.38 0.77 0.61

0.075 1.34 8.65 4.60 1.68 0.94 0.77 0.42 0.81 0.64

0.100 1.52 17.11 11.23 2.81 1.31 0.92 0.46 0.86 0.68

0.125 1.66 23.96 26.20 4.78 1.87 1.11 0.51 0.91 0.72

0.150 1.79 28.25 53.62 8.26 2.70 1.37 0.58 0.97 0.77

0.200 1.99 34.05 116.82 25.23 5.97 2.16 0.75 1.13 0.89

0.250 2.17 39.23 144.01 70.68 14.13 3.62 1.03 1.35 1.06

0.500 3.09 67.32 182.20 254.70 576.57 129.60 11.20 5.72 4.26
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Table 20. The relative efficiency of the ACS HH estimator to the SRS estimator of the 
total for Population 5 (T=625, Area= 6000 m2) with sample unit lengths ranging 
from 1 m to 15 m and initial sampling fractions ranging from 0.01 to 0.50. The 
condition to include additional units in a sample is C1 {i: yi > 0}.

n1 / N
Sample Unit Length (m)

1 2 3 4 5 7.5 10 12.5 15

0.010 0.65 0.26 0.38 0.41 0.33 0.42 0.33 0.61 0.51

0.025 0.70 0.36 0.46 0.45 0.34 0.42 0.32 0.59 0.50

0.050 0.78 0.53 0.59 0.52 0.37 0.42 0.32 0.57 0.49

0.075 0.83 0.68 0.72 0.59 0.40 0.42 0.31 0.55 0.48

0.100 0.88 0.79 0.83 0.65 0.44 0.43 0.31 0.54 0.47

0.125 0.91 0.87 0.92 0.71 0.48 0.44 0.31 0.52 0.46

0.150 0.94 0.94 1.00 0.77 0.52 0.46 0.31 0.51 0.46

0.200 0.98 1.05 1.12 0.86 0.60 0.50 0.31 0.50 0.44

0.250 1.01 1.12 1.22 0.93 0.67 0.55 0.33 0.49 0.44

0.500 1.08 1.32 1.48 1.18 0.96 0.84 0.46 0.61 0.46

Table 21. The relative efficiency of the ACS HH estimator to the SRS estimator of the
total for Population 5 (T=625, Area= 6000 m2) with sample unit lengths ranging 
from 1 m to 15 m and initial sampling fractions ranging from 0.01 to 0.50. The 
condition to include additional units in a sample is C2 {i: yi > 1}.

n1 / N
Sample Unit Length (m)

1 2 3 4 5 7.5 10 12.5 15

0.010 0.75 0.32 0.41 0.45 0.42 0.52 0.35 0.74 0.59

0.025 0.79 0.42 0.48 0.49 0.43 0.53 0.35 0.73 0.58

0.050 0.84 0.57 0.61 0.56 0.47 0.53 0.34 0.72 0.58

0.075 0.88 0.70 0.74 0.63 0.50 0.54 0.34 0.72 0.57

0.100 0.91 0.79 0.85 0.70 0.53 0.56 0.34 0.71 0.57

0.125 0.93 0.87 0.95 0.76 0.57 0.57 0.34 0.70 0.56

0.150 0.95 0.93 1.03 0.81 0.60 0.59 0.34 0.70 0.56

0.200 0.98 1.02 1.15 0.90 0.66 0.63 0.35 0.69 0.55

0.250 1.00 1.08 1.24 0.97 0.72 0.68 0.36 0.70 0.55

0.500 1.05 1.24 1.48 1.17 0.92 0.93 0.48 0.81 0.59
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Population 6

Table 22. The relative efficiency of the ACS HT estimator to the SRS estimator of the 
total for Population 6 (T=1997, Area= 220,400 m2) with sample unit lengths 
ranging from 1 m to 15 m and initial sampling fractions ranging from 0.01 to 
0.50. The condition to include additional units in a sample is C1 {i: yi > 0}.

n1 / N
Sample Unit Length (m)

1 2 3 4 5 6 7 8 9 10 12.5 15

0.010 1.04 1.02 0.86 0.65 0.60 0.54 0.50 0.53 0.50 0.51 0.42 0.39

0.025 1.07 1.15 1.15 1.09 1.00 0.93 0.83 0.85 0.74 0.73 0.57 0.50

0.050 1.10 1.37 1.66 1.83 1.79 1.70 1.53 1.63 1.33 1.28 0.90 0.76

0.075 1.13 1.56 2.15 2.57 2.66 2.54 2.38 2.61 2.10 2.03 1.34 1.11

0.100 1.16 1.72 2.60 3.32 3.64 3.48 3.43 3.76 3.00 2.98 1.87 1.55

0.125 1.18 1.85 3.00 4.03 4.71 4.52 4.75 5.10 4.03 4.11 2.47 2.07

0.150 1.20 1.96 3.33 4.66 5.80 5.60 6.41 6.65 5.22 5.45 3.15 2.64

0.200 1.23 2.13 3.86 5.64 7.85 7.74 10.73 10.37 8.16 9.03 4.77 3.84

0.250 1.26 2.27 4.27 6.35 9.57 9.70 15.94 14.66 11.90 14.18 6.97 5.11

0.500 1.37 2.78 5.66 8.52 14.68 16.54 35.49 35.29 37.56 55.92 37.36 13.08

Table 23. The relative efficiency of the ACS HT estimator to the SRS estimator of the 
total for Population 6 (T=1997, Area= 220,400 m2) with sample unit lengths 
ranging from 1 m to 15 m and initial sampling fractions ranging from 0.01 to 
0.50. The condition to include additional units in a sample is C2 {i: yi > 1}.

n1 / N
Sample Unit Length (m)

1 2 3 4 5 6 7 8 9 10 12.5 15

0.010 1.02 1.04 0.98 0.81 0.69 0.65 0.57 0.54 0.54 0.54 0.51 0.47

0.025 1.03 1.08 1.10 1.02 0.90 0.94 0.84 0.83 0.77 0.74 0.65 0.58

0.050 1.04 1.15 1.33 1.44 1.32 1.50 1.36 1.51 1.28 1.19 0.96 0.82

0.075 1.05 1.21 1.57 1.95 1.85 2.11 1.94 2.36 1.93 1.78 1.36 1.11

0.100 1.06 1.27 1.82 2.51 2.46 2.74 2.59 3.35 2.66 2.49 1.85 1.45

0.125 1.06 1.33 2.05 3.07 3.15 3.42 3.35 4.50 3.48 3.30 2.40 1.83

0.150 1.07 1.38 2.26 3.59 3.88 4.16 4.25 5.83 4.39 4.22 3.00 2.23

0.200 1.09 1.46 2.62 4.45 5.35 5.73 6.59 9.06 6.62 6.55 4.41 3.10

0.250 1.10 1.54 2.88 5.09 6.61 7.29 9.58 12.88 9.41 9.78 6.21 4.09

0.500 1.15 1.85 3.66 6.89 9.36 12.48 24.79 28.43 26.19 34.61 27.29 12.05
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Table 24. The relative efficiency of the ACS HH estimator to the SRS estimator of the 
total for Population 6 (T=1997, Area= 220,400 m2) with sample unit lengths 
ranging from 1 m to 15 m and initial sampling fractions ranging from 0.01 to 
0.50. The condition to include additional units in a sample is C1 {i: yi > 0}.

n1 / N
Sample Unit Length (m)

1 2 3 4 5 6 7 8 9 10 12.5 15

0.010 1.03 0.96 0.77 0.52 0.49 0.44 0.42 0.45 0.43 0.45 0.39 0.37

0.025 1.04 1.01 0.87 0.66 0.61 0.57 0.52 0.55 0.51 0.52 0.45 0.41

0.050 1.05 1.07 0.99 0.82 0.77 0.73 0.66 0.69 0.64 0.63 0.55 0.48

0.075 1.05 1.11 1.07 0.93 0.87 0.85 0.77 0.81 0.74 0.73 0.64 0.55

0.100 1.06 1.14 1.12 1.00 0.96 0.95 0.86 0.91 0.83 0.81 0.72 0.62

0.125 1.06 1.16 1.17 1.06 1.02 1.02 0.93 0.98 0.90 0.88 0.79 0.68

0.150 1.06 1.18 1.20 1.11 1.07 1.08 0.99 1.05 0.95 0.94 0.84 0.74

0.200 1.06 1.20 1.25 1.18 1.15 1.18 1.08 1.15 1.05 1.03 0.93 0.84

0.250 1.07 1.22 1.28 1.23 1.21 1.25 1.16 1.23 1.12 1.11 1.01 0.92

0.500 1.08 1.27 1.37 1.37 1.36 1.44 1.37 1.46 1.32 1.34 1.22 1.17

Table 25. The relative efficiency of the ACS HH estimator to the SRS estimator of the 
total for Population 6 (T=1997, Area= 220,400 m2) with sample unit lengths 
ranging from 1 m to 15 m and initial sampling fractions ranging from 0.01 to 
0.50. The condition to include additional units in a sample is C2 {i: yi > 1}.

n1 / N
Sample Unit Length (m)

1 2 3 4 5 6 7 8 9 10 12.5 15

0.010 1.02 1.02 0.93 0.74 0.63 0.56 0.50 0.47 0.48 0.49 0.48 0.45

0.025 1.02 1.03 0.95 0.79 0.69 0.66 0.60 0.56 0.56 0.56 0.53 0.49

0.050 1.02 1.04 0.99 0.86 0.78 0.79 0.72 0.70 0.68 0.66 0.62 0.56

0.075 1.02 1.05 1.03 0.92 0.85 0.88 0.81 0.82 0.78 0.76 0.70 0.63

0.100 1.02 1.06 1.05 0.97 0.91 0.94 0.88 0.91 0.86 0.83 0.77 0.69

0.125 1.02 1.06 1.07 1.00 0.96 1.00 0.93 0.99 0.92 0.90 0.83 0.75

0.150 1.02 1.07 1.09 1.03 1.00 1.04 0.98 1.05 0.98 0.95 0.89 0.80

0.200 1.02 1.08 1.11 1.08 1.06 1.11 1.06 1.14 1.07 1.04 0.97 0.89

0.250 1.02 1.08 1.13 1.11 1.11 1.16 1.11 1.22 1.13 1.10 1.04 0.96

0.500 1.02 1.10 1.18 1.20 1.22 1.30 1.27 1.41 1.31 1.28 1.24 1.18


